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Getting started with Macrobond 

In this document you will learn the basics of the Macrobond application. Among the things that 

will be briefly explained are: 

- How to browse the database and quickly view prepared charts and reports 

- How to create documents with analyses and presentations 

- How to create your own chart style sheets so that you can get the same look of many 

charts 

This document refers to version 1.5 of the Macrobond application. 
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Application main elements 

These are the main application elements that are always present. 

 

By selecting an Activity you select the main mode of the application. 

The Command bar contains commands, properties and tools on different tabs. The set of tabs 

depends on the chosen Activity. 

The Action tab of the Command bar is always available and shows actions you can do based on 

the most recently selected Entity. An Entity is a Country, Company, Time series, Region, 

Exchange, Index or a Security. Most actions will display different types of charts and reports. 

The Menu contains commands that are either always available, such as Open in the file menu, or 

are specific to the current Activity. The Toolbar contains the most commonly used commands. 

The Start Activity 

The Start Activity page contains a list of recently used documents, user guides and a list of the 

latest news from Macrobond. 

You will get a notification when there are new news items. 
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The Browse Activity 

With the Browse Activity you can easily find, compare and visualize data from the database. 

You can look at overviews for countries and companies or look for specific time series and 

quickly view them as charts, reports and tables. Charts, tables and reports presented in Browse 

are intended to be just a quick and transient view of the data. 

 

You select a view of the database and then you can select an entity from the resulting list. When 

you select an entity, the Action tab will show the actions available for that entity. The name of 

the active entity is written at the top of the Action tab. 
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If you click on an action that produces a chart or a report, it will show up on the right hand side 

of the application. For instance, if you click on CPI you will see the corresponding chart like this: 

 

When you open a new presentation, such as a chart or a report, in Browse it will open in the 

active Tab and replace any chart or report in that Tab. This means that you can quickly view 

different presentations for the selected entity. 

You can have several tabs open at the same time. If you want to keep the current Tab, you can 

open a new one by pressing the + sign to the right of the Tabs. This will open an empty Tab and 

when you select another presentation it will be shown in the new Tab. 

   

Tip: If you hold down the Ctrl key when you select an action, a new Tab will be created. 
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“Use in tabs” and “Add to active” 

 

The actions “Use in tabs” and “Add to active” operate on the presentations currently open as 

Tabs in Browse. 

The action “Use in tabs” will, if possible, replace the entity currently used in the presentations, 

with the selected entity. For example, if you have a CPI chart for Denmark, select Belgium and 

then press “Use in tabs”, then the chart will show CPI for Belgium instead of Denmark. The little 

red arrow next to the entity names is a shortcut for this action. 

The action “Add to active” will attempt to add the selected entity to the presentation in the active 

Tab. For instance, if you have a CPI chart for Germany, select Denmark and press “Add to active” 

then you will get a chart like this: 

  

Tip: Shift+click on the red arrow next to the entity name is a shortcut for this action. 
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Enter text to search for 

For some database views you can enter a text to search for instead of navigating the list of 

categories. 

 

When you enter a text and press Enter, the database will be searched for all relevant entities that 

have some word in the title or description that begins with the text that you have entered. 

If several words are entered, all words must match. 

To clear the search mode and show the list of categories, press the X next to the text entry field 

or press Esc on the keyboard. 

 

Browse for time series 

When you select the Browse operation called “Time series” instead of “Overview”, you will 

browse the database for time series entities and you will be able to see the complete set of all 

time series. The charts and reports that appear in the Action tab will be general presentations 

that can be used for all time series. 

The chart in Browse 

When viewing a chart in Browse you can zoom in on the date axis by marking a range with the 

mouse. You can zoom out all the way by double clicking on the axis. 

You can select a graph in a chart by clicking on it. You may see the value and the date of the 

selected point by hovering the mouse over it. Selecting a graph will select the corresponding 

time series, and you will see the actions for that time series in the Action tab. In particular, the 

Time series information report will be available as an action in this case. 
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You can use the Ruler, which can be turned on in the Chart menu or toolbar, to see the values of 

all graphs at a specific point in time. 

 

If you want to save a chart as a document, you can select “Save as analytics document” in the File 

menu. 

If you want to do more changes to the charts or calculations, then you open a copy of the tab in 

the Analytics Activity as explained later in this document. 
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The Analytics Activity 

With the Analytics Activity you create documents where you can define calculations and 

presentations of data. 

 

The Analysis tree 

When you do calculations, the Analysis tree is the central part of an Analytics document. There 

are a number of Analyses that you can use as building blocks in a sequence of calculations. 

Typically, the last building block is a presentation such as a Time chart or a Table. 

When you create a new empty Analytics document, there will already be two building blocks in 

the Analysis tree: a Series list followed by a Time chart. 

You can insert new analyses to the sequence in the analysis tree. This is done by selecting the 

analysis that should follow the new analysis; select an analysis in the drop down list to the left of 

the Insert button and finally press Insert. 

In the image above, there are three building blocks: Series list, Rate of change and Time chart. 

The series listed in the Series list will be processed by the Rate of change analysis and finally 

presented in the Time chart. Click on an analysis in the tree in order to see the settings where 

you can make changes. 

To delete an analysis from the tree, select the analysis and then press Delete. (Either “Del” on the 

keyboard, Delete in the Edit menu or the X in the toolbar.) 
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Undo 

You can always undo your last action within an Analytics document. (Either select Undo on the 

Edit menu or press Ctrl+Z.) 

The Series list 

The Series list is always present in the Analysis tree and is the base for all calculations. It is this 

list of series expressions that are propagated to the subsequent analyses in the document. 

 

In the Series list, all series are converted to the same frequency and calendar. You can optionally 

select to convert all series expressed as money to the same currency. 

You can add series to the Series list in different ways: 

- If you happen to know the series name, or other series identifier, you can type it into the 

list directly. 

- You can use the Series browser to find your series and then press the “Add selected time 

series” button. 

- You can copy one or more series from a Series list in another document by using Copy 

and Paste. 

- Whenever you have selected one or more series in a chart, report or in the Search 

Activity, there will be actions in the Action bar that offer you to add those series to an 

Analytics document. 

In the Series list you can not only type in series names, but you can also type in formulas 

containing +, -, *, /, parenthesis and a number of functions. For instance, you may type an 

expression like this: 

sek/nok 

This will calculate the exchange rate between the Swedish and Norwegian Krona. 

There is a large set of built in formula functions and you can also define your own functions. 

There is much more information about the formula language in the document “Macrobond 

formula language” on the Getting started page. 

http://www.macrobondfinancial.com/index.php/support/getting-started
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The Time chart 

A time chart can display graphs of time series as lines or columns. The horizontal axis always 

represents time and the vertical axes represent the value of the time series at that time. 

 

When you click on a part of a chart, it will be selected. The tab “Presentation properties” in the 

Command bar shows the properties of the selected part and allows you to make changes. 

If you press the Esc key, the Chart background will be selected. 

Axis 

You can mark with the mouse on the time axis to zoom in on a range. If you want a more precise 

range, you can type in the start and end dates on the properties tab for the axis. By double 

clicking, you zoom all the way out. 

There are two values axes: the Main scale and the Alternate scale. For each graph you can select 

which scale it should use. The Main scale axis controls the grid lines and is always available. The 

axis for the Alternate scale is only displayed if there are any graphs that use it. The Main scale is 

typically drawn on the right hand side and the Alternate scale on the left, but the property “Main 

scale to the right” available for the axes allows you to change this. 
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Graphs 

If you select a graph, you actually select a specific point of a graph. You can get information 

about the value of the selected point by holding the mouse pointer over it. You can move the 

graph selection point by using the arrow keys. 

 

Another way to view the values of the graphs is to use the Ruler. You turn the ruler on and off 

with the Ruler command in the Chart menu or the icon in the toolbar. 
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On the Chart menu, you find the Graph layout dialog where you can select the graph type for 

each time series. You may also select that some time series should not be drawn as graphs at all. 

The order between the graphs can also be changed which is a way to control which graphs are to 

be drawn on the top of others. 

 

Legend 

The legend has properties such as the background color. However, if you want to change the text 

of a graph entry in the legend, you can do this by selecting a graph. 

The option “Show legend” is available both as a property for the legend and as a property for the 

chart background. 

Chart annotations 

You can add ornaments such as text boxes, lines and arrows to a chart. You may also draw ink on 

top of a chart by using the ink tools. All annotation tools are available in the “Chart annotations” 

tab in the Command bar. 
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To add an annotation, select the tool and then draw on the chart by pressing down the left 

mouse key. 

Tip: The ornament tools will be released when you have drawn an ornament and you will see 

the Presentation properties for the ornament. If you want to draw many lines or arrows, you can 

keep the Ctrl key down when drawing in the chart in order to prevent the tool from being 

released. 

Copy chart 

When the chart is selected, or any part in the chart, you can copy the whole chart to the 

clipboard. (Either selected Copy on the Edit menu, the copy button in the toolbar, the shortcut 

Ctrl+C or Copy from the context menu of the chart.) 

The chart will be copied as a picture that you can paste into other applications. On the clipboard 

there will also be a Macrobond chart object. In applications that support objects, such as 

Microsoft Office, you will not only get a picture of the chart when you paste the object, but you 

will also get the ability to update the chart if you have the Macrobond application installed. You 

can either just refresh the chart with the latest data or you can edit the chart. 

The commands for refresh and edit can be found on the context menu that is displayed when 

you click with the right mouse button on the Macrobond chart in the Office application. There is 

also a special Macrobond menu in Office where you will find a Refresh command that refreshes 

all charts in the Office document. 
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Creating Analytics documents from Browse presentations 

A common scenario is that you want to make changes to a chart that you have found in the 

Browse Activity. You can then open a copy of the chart in the Analytics Activity. You do this with 

the “Open in Analytics” command that you find on the File menu and in the toolbar. 

 

Once you have a copy of the document in Analytics, you can make changes to the chart, analyses 

and the set of series. 
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The Search Activity 

With the Search Activity you can search the database for all kinds of data. The search result will 

be grouped by entity type. 

You can select one or more entities in the search result and see the Actions for those entities. 

The search will be done for words in the title or descriptions of series that begin with the text 

you have written. If you type several words, all of them must match. 

The Release activity 

The Release activity shows a calendar of scheduled updates of economic data that is updated on 

a regular basis. You can filter on regions and define your own favorites. 

 

For the important releases there is a list of the main time series updated by the release. You can 

select one of the series and then use the Action bar to show the series or add it to a document. 
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The My series Activity 

The My series Activity is a secondary activity. This means that it might not be directly available 

among the Activity tabs and in that case you can find it using the popup menu shown by pressing 

the arrow key below the tabs. 

 

With the My series Activity you can create a list of series definitions that points to ranges in 

Excel sheets where the time series values are. When such a series is used, the application will 

load the Excel sheet and extract the values. The values are not stored by the Macrobond 

application; only the reference to the Excel sheet where the data is found. 

These steps are performed in order to define a series. 

1) Mark the range of data where your values are stored in an Excel sheet. The Excel 

document must be saved. The values must be stored in a column. You typically want to 

select the whole column so that any new values you add in the future will be included in 

the range. 

 
The series will start at the first row that contains a number. You can select one or more 

columns. If you have only one column, the application will assume that the columns 

contain the time series values. If you have more than one column, the application 
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assumes that the left most column contains dates and the right most contains values. If 

you mark more than two columns the ones in the middle are not used. 

2) Select Copy from the Edit menu in Excel. 

3) Switch to the Macrobond application, go to the My series Activity and press the “New 

series…” button at the bottom. 

 
4) Fill in a series name. This must be a unique name of only letters and digits. Also fill in a 

description, a region and a category. 

5) When you press the “Paste Excel link” button, the application will look at the clipboard 

and find the link that you copied from Excel in the first step. 

6) If you have included a date column, the frequency and start dates will be filled in 

automatically. Otherwise you have to specify these. 

When you have filled in all the data and pressed OK, your new series will be available to be used 

in the application. These series will not be different from any other series in the application and 

you can for instance find them in the Browse Activity if you select the database view called 

“Excel in-house series – by region”. 

If you move or rename your Excel document or move the data in a document, you need to inform 

the Macrobond application of these changes. You can change the link used by the application by 

selecting your series in the My Series activity and then press the “Edit link” button. 
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The Style sheet Activity 

With the Style sheet Activity you can create chart style sheets that allow you to define the visual 

style of charts. You can have several style sheets with different names and you can specify one of 

them to be used as the default for new documents. 

When you create or open a chart style sheet in the Style sheet Activity, you will see a sample 

chart. You edit the properties of the different chart elements by clicking on them and then 

change the settings in the “Presentation properties” tab in the Command bar just like you do 

when changing chart properties in the Analytics Activity. 

 

NB: You will not see all the properties that you see in the Analytics Activity. Only those 

properties that affect the style of the chart, and that can be applied to all types of charts 

regardless of data, are included. 

When you save a style sheet, you can select to store it in one of three different locations: 

- Private account: the style sheet is stored at Macrobond and is available to you on all 

computers where you run the Macrobond application using the same account. 

- My computer: the style sheet is stored on your computer and is only available on that 

computer. 

- Company account: the style sheet is stored at Macrobond and is available to everyone 

within your organization. 
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To use a style sheet in the Browse or Analytics Activity, select “Select chart style sheet…” from 

the “Style sheet” menu. In this dialog you have the option to check the “Use as default for new 

charts”. 

 

When you apply a style sheet, the settings from that sheet are copied to your chart. If you make 

changes to your style sheet it will not affect any charts unless you apply the style sheet again. 

Tip: If you have designed a chart in the Analytics Activity and would like to create a style sheet 

with that style, you can select the “Open in style sheet editor…” on the “Style sheet” menu. 
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The Macrobond Excel add-in 

With the Macrobond Excel add-in you can import data from Macrobond into Microsoft Excel and 

easily keep it updated with the latest values. You can also upload data from Excel and use as in-

house series in Macrobond. 

Depending on your version of Excel, the add-in can look a bit different. 

 

You can add data in two forms: 

- As a Time series - this will import all the values of one or more time series that you 

select. 

- As a Report - this will import the last value of predefined reports, such as company 

account data. 

Import time series 

There are three different methods that can be used for importing time series from Macrobond 

into Excel: selecting series by using the data navigator, use series from country and company 

overviews or use the result of a calculation in a Macrobond document. 
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Select series by using the data navigator 

The All series button in the Macrobond add-in toolbar/menu will bring up a dialog like this: 

 

You then select one or more time series using the database navigator. 

There are two import modes: 

Processed All series in the set are converted to the same frequency and calendar and there is 

only one column/row of dates. You may select rate of change calculations and scale 

for each series. 

Raw Series are treated separately and there is a column/row of dates for each series. 
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Get series from country and company overviews 

The Overview button in the toolbar/menu allows you to do cross-country or cross-company 

comparisons of data in Excel. Selecting it will display a dialog like this: 

  

Add one or more countries or companies by using the Database navigator. Then select the type 

of overview. 

Use the result from a Macrobond document 

You can use the result of any calculation in a Macrobond document and turn it into a Macrobond 

Excel Data set. There are several ways you can do this: 

1) You can press the Import button/menu item in the Macrobond Excel add-in and select a 

saved Macrobond document. 
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2) You can select “Copy as Excel Data set” on the Edit or context menu when an analysis is 

selected in a Macrobond document that you can paste into Excel: 

 
3) Select values in a Table presentation in the Macrobond application and then select “Copy 

special” from the Edit or context menu. Select to copy a Data set instead of Text and then 

paste the result into Excel: 
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When you copy or import time series from a Macrobond document into a Data set, a copy of all 

calculations is stored in the Data set and there is no dependency on the document where the 

data came from. In order to edit the calculations used by the Data set, press the “Edit 

document…” button: 

 

This will open a document tab in the Macrobond application where you can view and change the 

calculation settings. 

Data sets 

When you have imported data to the Excel sheet you will notice a red object in your sheet with 

the text “Macrobond Data set”. It is this object that keeps track of what series and settings you 

have selected. 

 

If you select the red Data set objet and press the “Edit selected data set” in the toolbar/menu, 

you will once again see the dialog where you select series and settings. 
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When you press the Refresh button in the toolbar/menu, all data in the current workbook will 

be updated with the latest information. 

Data is always placed in the sheet relative the Data set object. If you move the Data set object, 

you will notice that the data is imported to a new position the next time you select Refresh. 

Please note that if you remove the Data set object, the information can no longer be updated 

when you select Refresh. 

You can have any number of Data sets in a workbook. 

Import reports 

Press the Report button in the toolbar/menu to bring up the report selection dialog. When you 

select an entity, such as a company or a country, for which there are reports, you will see a list of 

the reports at the top of the dialog. When you select a report then a new tab will be created on 

the right hand side. 

 

You can add more entities to each report by selecting the entity and then pressing “Add to active 

report”. 

Each new report will be imported to a new sheet. 

Uploading in-house series 

You can upload time series data from an Excel sheet into your in-house account database in 

Macrobond. This is done by creating a template in your Excel sheet that contains information 

about each time series. The template must follow a strict layout. The easiest way to create the 
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template is to press the “Create template” button/menu item in the Macrobond Excel add-in. 

This will bring up a dialog where you fill in the information needed to create the template: 

 

When you press Create, the template is created in you sheet: 

 

You can edit the template by selecting the “Edit template” button/menu item in the add-in. 

You need to fill in at least one date and one or more values. If only the first date is specified, the 

selected frequency will used to deduct the following dates. 
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You can have several templates in the same sheet. If you want to use the same dates for another 

series, you can copy the column of values like this: 

 

You use the “Upload all templates” button/menu item, which will look for templates on all the 

sheets in the workbook, or “Upload selected templates”, which will look for templates in the 

range of selected cells. 

If you upload new series while the Macrobond application is running, you might have to press 

the Refresh button in order to see the new series immediately: 

 

 


